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notices 

notices 

●     notices and acknowledgements 

●     terms and conventions 
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notices and acknowledgements 

notices and acknowledgements 

hewlett-packard company notices 

The information contained in this document is subject to change without notice. 

Hewlett-Packard (HP) makes no warranty of any kind with regard to this material 
including, but not limited to, the implied warranties of merchantability and fitness for a 
particular purpose. 

Hewlett-Packard shall not be liable for any errors or for incidental or consequential 
damages in connection with the furnishing, performance, or use of this material. 

All rights reserved. Reproduction, adaptation, or translation of this material is prohibited 
without prior written permission of Hewlett-Packard, except as allowed under copyright 
laws. 

acknowledgments 

Microsoft, MS, MS-DOS, Windows, and XP are registered trademarks of Microsoft 
Corporation. 

TrueType is a U.S. trademark of Apple Computer, Inc. 

Adobe and Acrobat are trademarks of Adobe Systems Incorporated. 

Copyright 2002 Hewlett-Packard Company 
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terms and conventions 

terms and conventions 

The following terms and conventions are used in the User’s Guide. 

terms 

HP Deskjet printers may be referred to as the printer. 

symbols 

The > symbol guides you through a series of software steps. For example: 

Click Start > Programs > Hewlett-Packard > [hp deskjet series] > release notes 
to open the Release Notes. 

cautions and warnings 

A Caution indicates possible damage to the HP Deskjet printer or to other equipment. 
For example: 

Caution! Do not touch the print cartridge ink nozzles or copper contacts. 
Touching these parts will result in clogs, ink failure, and bad electrical 
connections. 

A Warning indicates possible harm to yourself or to others. For example: 

 
Warning! Keep both new and used print cartridges out of the reach of 
children.

icons 

A Note icon indicates that additional information is provided. For example: 

 
For great results use HP products. 

A Mouse icon indicates that additional information is available through the What’s 
This? help feature. For example: 
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terms and conventions 

 

To find more information about options on each tab screen, point to an 
option and click the right mouse button to display the What’s This? 
dialog box. Click What’s This? to view more information about the 
selected option. 

A Printing instructions icon indicates that a description of print options is available in 
the User's Guide. For example: 

 
For a description of available print options, see print settings.
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special features

special features

Congratulations! You have purchased an HP Deskjet printer that is equipped with several 
exciting features:

Photo print cartridge: Great performance, with a photo print cartridge that prints 
stunning true-to-life photos.

Digital photo printing: Enhanced digital photo printing capabilities.

Borderless printing: Photos and cards print to the edges of the paper with borderless 
printing.

Print screen: Print screen images print at the touch of a button.

Reserve mode: Reserve mode lets you continue printing with one print cartridge when 
the other print cartridge has run out of ink.

Auto-On and Auto-Off: Enable Auto-Off to place the printer into a low-power, energy-
efficient mode after it has been idle for 30 minutes. The printer turns on automatically 
when you print a file. 

Poster Printing: Poster printing lets you print a poster on multiple pages which can be 
taped together. 
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buttonsandlights 

getting started 

●     printer features 

●     buttons and lights 

●     paper trays 

●     print cartridges 

●     reserve mode 

●     automatic paper-type sensor 

●     automatic two-sided printing module (duplexer) 

●     connectivity 
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printerfeatures 

printer features 

The HP printer has several features to make printing easier and more efficient. 

To view a printer feature, click below on the name of the feature. 

 

1. buttons and lights 

2. paper trays 

 

1. reserve mode 

2. print cartridges 

3. automatic paper-type sensor 
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printerfeatures 

 

1. connectivity 

2. duplexer 
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buttonsandlights

buttons and lights

The printer buttons let you turn the printer on and off, cancel a print job, or resume 
printing. The lights give you visual cues about the status of the printer.

 

1. Cancel button 2. Print Cartridge Status light 
3. Resume button and light 4. Power button and light

cancel button

Pressing the Cancel button cancels the current print job.

print cartridge status symbol and light

The Print Cartridge Status light turns on or flashes when a print cartridge needs service.

resume button and lights

The Resume light flashes when an action is required such as loading paper or clearing a 
paper jam. When the problem is solved, press the Resume button to continue printing.

power button and light

The Power button turns the printer on and off. It may take a few seconds for the printer 
to turn on after pressing the Power button. The green light next to the Power button 
flashes when the printer is processing.
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buttonsandlights

Caution! Always use the Power button on the front of the printer to turn the 
printer on and off. Using a power strip, surge protector, or a wall-mounted 
switch to turn the printer on and off may cause printer failure.
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paper_trays

paper trays 

The printer has two paper trays: an In tray and an Out tray. The Out tray contains a slot 
for single envelope printing.

 

1. Out tray 2. In tray 3. single envelope slot

in tray

The In tray holds paper or other media to be printed.

You can print different sizes of media by sliding the paper guides in and out.

 

1. paper width guide 2. paper length guide

out tray

Printed pages are deposited in the Out tray.

Remove the Out tray to load paper. 
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paper_trays

 

Replace the Out tray before printing.

Out tray extension - Fold the Out tray extension out when printing a large number of 
pages. Also fold out the extension when printing in draft mode to prevent the paper 
from falling out of the tray. When the print job finishes, fold the tray extension into its 
storage slot. 

 

1. Out tray extension
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inkdelivery

print cartridges

Three print cartridges can be used with your printer:

●     black print cartridge

●     tri-color print cartridge

●     photo print cartridge

 

1. black print cartridge 2. tri-color print cartridge 3. photo print cartridge

print cartridge selection

print cartridge selection number product 
number 

black 
 

c6656a 

tri-color 
 

c6657a 

photo print 
 

c6658a 

For installation instructions, see replacing print cartridges.

For storage instructions, see maintaining print cartridges.

For recycling instructions, see print cartridge recovery.

 

For print cartridge ink capacity, see the information included in the 
print cartridge packaging.

file:///C|/Projects/Newport/Win_UG_Hykuna/ug_ink_delivery_fs.html [5/9/2002 10:12:38 AM]

16



media_sensor

automatic paper-type sensor

The Automatic Paper-Type Sensor determines the correct paper type and adjusts the 
print settings for most paper or media placed in the paper tray. Automatic is the 
default option in the Printer Properties dialog box.

This feature, particularly when used with HP paper and media, provides better printing 
results. 

When the Automatic default option is selected, the Automatic Paper-Type Sensor is 
engaged. The printer scans the first page of a document with a blue optical sensor light 
to determine the best paper type setting. Once determined, the page is printed.

For more information, see using the automatic paper type sensor.
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reservemode

reserve mode

Reserve mode allows the printer to operate using only one print cartridge. It is initiated 
when a print cartridge is removed from the cradle.

1. remove print cartridge to initiate reserve mode 

reserve mode output

Printing in reserve mode slows the printer and affects the quality of printouts.

when only this print cartridge 
is installed... the result is...

black print cartridge Colors are printed as grayscale.

tri-color print cartridge 

Colors print but black is grayed and is 
not a true black.

Printing a black text or monochrome 
document with a tri-color print 
cartridge increases printing time.

photo print cartridge Colors are printed as grayscale.

file:///C|/Projects/Newport/Win_UG_Hykuna/ug_reservemode_fs.html (1 of 2) [5/9/2002 10:12:39 AM]

18



reservemode

exiting reserve mode

Install two print cartridges in the printer to exit the reserve mode.

For instructions on installing a print cartridge, see replacing print cartridges.
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duplexer

automatic two-sided printing module (duplexer)

The Automatic Two-Sided Printing Module (duplexer) is a special hardware feature that 
enables the printer to automatically print on both sides of a page.

 

installing the duplexer

1.  Turn the latch counter-clockwise on the printer’s Rear Access Door and remove 
the door.

 

Do not discard the Rear Access Door. In order to print, the Automatic Two-Sided 
Printing Module or the Rear Access Door must be attached to the printer.

2.  Insert the Automatic Two-Sided Printing Module in the back of the printer until 
both sides snap into place.
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duplexer

 

Do not press the buttons on either side of the Automatic Two-Sided Printing 
Module when installing it in the printer. Use these buttons only when removing 
the Automatic Two-Sided Printing Module from the printer.

supported paper types

The Automatic Two-Sided Printing Module only works with certain media types. For a list 
of supported media types, see automatic two-sided printing module specifications.
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connectivity

connectivity

The printer offers a number of options for connectivity, including:

●     USB 

●     parallel 

●     network 

USB

The printer connects to the computer with a USB cable. Your computer must be running 
Windows 98, Me, 2000, or XP operating system to use a USB cable.

 

For instructions on connecting the printer with a USB cable, see the Setup poster that 
came with the printer.

parallel

The printer can connect to your computer with a parallel cable.

 

For instructions on connecting with a parallel cable, see the Setup poster that came with 
the printer.

network

The printer can be connected to a network in one of two ways: 

●     The printer can be connected directly to a computer on the network.

For instructions on connecting the printer directly to a computer on the network, 
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connectivity

use the printer software CD and follow the on-screen network setup instructions.

●     The printer can be connected to a network with an HP JetDirect Print Server.

For instructions on connecting the printer to a network with an HP JetDirect Print 
Server, use the printer software CD and the documentation that came with the HP 
JetDirect Print Server.
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printing 

printing 

Click the following topic below to view an explanation of the printer software: 

●     print settings 

●     advanced features 

●     printing digital photographs 

●     changing default print settings 

●     auto-on and auto-off feature 

Click the appropriate topic below to view instructions on printing functions: 

●     printing a document 

●     using the print status box 

●     printing a screen image 

●     two-sided printing 

●     using the automatic paper-type sensor 

●     borderless printing 

Click the appropriate topic below to view instructions for printing on different paper 
types: 

●     plain paper 

●     envelopes 

●     transparencies 

●     labels 

●     index cards and other small media 

●     Hagaki cards 

●     photographs 

●     greeting cards 

●     posters 

●     banners 

●     iron-on transfers 
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print settings

print settings

The printer is controlled by software installed on your computer. Use the printer 
software, known as the printer driver, to change the print settings for a document.

To change printer settings, open the Printer Properties dialog box.

displaying the printer properties dialog box

Follow these steps to display the Printer Properties dialog box:

1.  Open the file you want to print.

2.  Follow one of these paths to select the Printer Properties dialog box, depending on 
the software program you are using: 

❍     Click File > Print, then select Properties.

❍     Click File > Print Setup, then select Properties.

❍     Click File > Print > Setup, then select Properties.

The Printer Properties dialog box appears.

using the printer properties dialog box

The Printer Properties dialog box has several tools to make it easy to use.

In addition to the tabs shown below, the Printer Properties dialog box may also have a 
Services tab. See tools for further information.

quality tab

The Quality tab allows you to set these options:
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print settings

 

1.  Print Quality: Quality of printout. There are four options to choose from: Best, 
Normal, Everyday, and FastDraft. Best provides the best print quality at the 
slowest printing speed. The print speed increases and the print quality lessens 
with Normal, Everyday, and FastDraft. FastDraft provides draft quality at the 
fastest printing speed. 

2.  HP Digital Photography: See printing digital photographs.

3.  Paper Type: Type of paper used. Automatic is the default setting. It enables the 
printer to automatically select the paper type.

4.  High Resolution Control: Quality of graphic printing on certain papers, such as 
hp photo papers.

5.  Factory Settings: Returns all settings to the factory default values. 
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print settings

layout tab

The Layout tab allows you to set these options:

 

1.  Paper Size: Size of paper used.

2.  Borderless Printing: See borderless printing.

3.  Orientation: Page layout.

4.  Mirror Image/Rotate 180º: Advanced orientation options.

5.  Scale to Fit: Size of text and images on a page.

6.  Copies: Number of copies printed.

7.  Start Printing from Last Page: Print the last page first.

file:///C|/Projects/Newport/Win_UG_Hykuna/ug_printerproperties_fs.html (3 of 6) [5/9/2002 10:12:41 AM]

27



print settings

8.  Factory Settings: Returns all settings to the factory default values.

features tab

The Features tab allows you to set these options:

 

1.  Two-Sided Printing: See two-sided printing.

2.  Pages per Sheet: Number of pages printed on each sheet of paper.

3.  Draw Page Border: Place border around each page on a sheet of paper.

4.  Page Order: Order in which multiple pages appear on a sheet of paper.

5.  Advanced Features: See advanced features.
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print settings

6.  Poster Printing: Number of paper sheets used to print a poster.

7.  Printing Ideas: Creative ideas for printing.

8.  Factory Settings: Returns all settings to the factory default values.

color tab

The Color tab allows you to set these options:

 

1.  Print in Grayscale: Print in shades of gray.

2.  Saturation: Intensity of printed colors.

3.  Brightness: Lightness or darkness of printed colors.

file:///C|/Projects/Newport/Win_UG_Hykuna/ug_printerproperties_fs.html (5 of 6) [5/9/2002 10:12:41 AM]

29



print settings

4.  Color Tone: Warmth or coolness of printed colors.

5.  Factory Settings: Returns all settings to the factory default values.

 

To find more information about options on each tab screen, point to an 
option and click the right mouse button to display the What's This? 
dialog box. Click What's This? to view more information about the 
selected option.

You may also have a Services tab. See tools for further information.
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advancedfeatures 

advanced features 

Printing photographs, transparencies, or documents with graphics may require you to 
set several options in the Advanced Features dialog box.

accessing the advanced options dialog box

Follow these steps to access the Advanced Features dialog box:

1.  Open the Printer Properties dialog box.

2.  Click the Features tab, then click the Advanced Features button.

using the advanced features dialog box

Use the Advanced Features dialog box to set these options:

file:///C|/Projects/Newport/Win_UG_Hykuna/ug_advancedfeatures_fs.html (1 of 2) [5/9/2002 10:12:42 AM]

31



advancedfeatures 

 

1.  Ink Volume: Select this feature to lessen or increase the amount of ink used to 
print a document.

2.  Dry Time: Select this feature to increase the time the printer holds a document 
after printing if the ink on your printed document smears.

3.  Low Memory Mode: Select this option to allow the draft to be printed if your 
computer does not have enough memory or disk space to print a document.

 
Using Low Memory Mode may reduce the quality of your printout.
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printingdigitalphotographs

printing digital photographs

The hp deskjet printer has several features to improve the print quality of your digital photographs. 
These features are found in the HP Digital Photography Options dialog box.

To access these options:

1.  Open the Printer Properties dialog box. 

2.  Click the Quality tab, then click the HP Digital Photography button. 

using the hp digital photography options dialog box

Use the HP Digital Photography Options dialog box to set these options:
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printingdigitalphotographs

1.  Contrast Enhancement: Adjust contrast to preference. Click Auto to allow the printer driver 
to automatically balance contrast. 

2.  Digital Flash: Lighten dark images. Click Auto to allow the printer driver to automatically 
balance lightness and darkness. 

3.  SmartFocus: Click On to allow the printer driver to automatically focus images. 

4.  Sharpness: Adjust image sharpness to preference. Click Auto to allow the printer driver to 
automatically balance sharpness. 

5.  Smoothing: Adjust distortion to preference. Click Auto to allow the printer driver to 
automatically balance smoothing. 
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changing default settings

changing printer settings 

The taskbar icon lets you change the default print settings. Default print settings apply 
to all documents you print with your HP Deskjet printer.

 

1. taskbar icon

using the taskbar icon shortcut menu

1.  Right-click the taskbar icon.

2.  Select Change Default Print Settings.

The Printer Properties dialog box appears.

3.  Select the print properties you wish to use for the default print settings.

4.  Click OK.

A dialog box appears stating that the new settings will be used every time you 
print. If you do not want to see this dialog box again, select Don't show me this 
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changing default settings

message again.

5.  Click OK to save the new default print settings.

These settings will remain in effect unless you change the default print settings 
again.

turning off the taskbar icon

1.  Right-click the taskbar icon.

The taskbar shortcut menu screen appears.

2.  Select Exit to turn off the taskbar icon.

turning on the taskbar icon 

Click Start > Programs > Hewlett-Packard > hp deskjet series > taskbar icon. 
The taskbar appears automatically whenever you restart you computer.
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auto-on and auto-off feature

enabling Auto-On

Auto-On is a default feature of the printer. The printer automatically turns on when you 
print a file.

enabling Auto-Off

Enable the Auto-Off feature to place the printer in a low-power, energy-efficient mode 
after it has been idle for 30 minutes.

Instructions for enabling the Auto-Off feature vary depending on how the printer was 
installed on your computer.

To view the correct instructions, answer the following question:

Does this icon appear on your computer's desktop?

 

●     Yes (use printer assistant)

●     No (use printer properties)

accessing auto-off from the printer assistant 

1.  Click configure printer.

2.  Click the Configure button.

The HP Deskjet Toolbox screen appears.

3.  Select the Configuration tab.

4.  Select Activate the Hardware Auto-off feature to turn on the feature.

–or–

De-select Activate the Hardware Auto-off feature to turn off the feature.

5.  Click Apply.
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auto off

accessing auto-off from printer properties

1.  Open printer properties.

2.  Click the Services tab.

3.  Click the HP Toolbox button.

The HP Deskjet Toolbox screen appears.

4.  Select the Configuration tab.

5.  Select Activate the Hardware Auto-off feature to turn on the feature.

–or–

De-select Activate the Hardware Auto-off feature to turn off the feature.

6.  Click Apply.
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printing a document

printing a document

Follow these instructions to print a document or change your print settings:

1.  Open the file you want to print.

2.  Follow one of these paths to open the Printer Properties dialog box:

❍     Click File > Print, then select Properties.

❍     Click File > Print Setup, then select Properties.

❍     Click File > Print > Setup, then select Properties. 

The Printer Properties dialog box appears.

3.  Select the Quality tab to choose print quality options, Automatic or a specific 
paper type, resolution, and HP Digital Photography options.

The Automatic Paper-Type Sensor automatically sets the paper-type option. 
Automatic is the default setting.

4.  Select the Layout tab to choose paper size, borderless printing, orientation, 
number of copies printed, and print order.

5.  Select the Features tab to choose two-sided printing, multiple pages per sheet, 
and poster printing.

6.  Select the Color tab to make color and contrast adjustments.

7.  Click OK to return to the Print or Print Setup screen.

The Printer Properties dialog box may also display the Apply 
button. The Apply button saves changes to settings without 
closing the dialog box.

8.  Click OK to print. 
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print status box 

print status box 

The Print Status box appears each time the printer prints a file. 

 

The following items are displayed: 

●     Ink Level: Approximate ink level of each print cartridge 

●     Status: Status of the print job 

●     Print Quality: FastDraft, Everyday, Normal, or Best 

●     Paper Type: Type of paper used 

●     Paper Size: Size of paper used 

To change the print options, click the taskbar icon. 
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print status box 

To cancel a print job, click Cancel Print. 

To close the Print Status box, click Close Window. 
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printing a screen image

printing a screen image

The HP Print Screen Utility* allows you to print a screen image displayed on the 
computer monitor. It works when your HP deskjet printer is selected as the default 
printer. 

*This option may not be available depending on printer installation. 

printing guidelines

Use either letter-sized or A4-sized paper to print the image.

print screen button

●     Press the Print Screen button on the keyboard to print a screen.

-or-

●     Press the Alt and the Print Screen button on the keyboard at the same time 
to print an active application window.

configuring the hp print screen utility 

Access the HP Print Screen Utility configuration window in Windows from Start > 
Programs > Hewlett-Packard > hp print screen.

Use the configuration window to set up various options for the HP Print Screen Utility:

1.  Unload/Load HP Print Screen activates or deactivates the utility. 

2.  Start with Windows determines whether the HP Print Screen Utility launches 
automatically when Windows is started. 

3.  Capture screen performs the same action as if the Print Screen button on the 
keyboard were pressed. 

4.  Orientation toggles between landscape and portrait mode. 
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two-sided printing

Use one of the following methods to print two-sided documents:

●     automatic two-sided printing 

●     manual two-sided printing 

automatic two-sided printing

To print two-sided documents automatically, the Automatic Two-Sided Printing Module 
(duplexer) must be attached to the printer.

The duplexer only works with certain media types. For a list of supported media types, 
see automatic two-sided printing module specifications.

If you want to print a two-sided document on a media type not supported by the 
automatic two-sided printing module, see manual two-sided printing.

printing instructions

Follow these instructions to print a two-sided document:

1.  Open the Printer Properties dialog box, then select the Features tab. 

2.  Check Two-Sided Printing.

The Two-Sided Printing Margin dialog box appears.

3.  Select the appropriate page content option, then click OK to return to the 
Features tab. 

4.  Select Long Side (binding on the side) or Short Side (binding at the top). 

5.  Select the Automatic box.
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two-sided printing

 

6.  Change any other desired print settings, then click OK. 

When the first side prints, the printer pauses while the first side of the printed page 
dries. Once dry, the second side of the page is printed and released.

For a description of the automatic two-sided printing module, see automatic two-sided 
printing module.

manual two-sided printing

Use the manual two-sided printing feature if:

●     The Automatic Two-Sided Printing Module (duplexer) is not attached to the 
printer. 
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●     You want to print a two-sided document on a media type the Automatic Two-
Sided Printing Module does not support. 

rear access door

If the Automatic Two-Sided Printing Module is not attached to the printer, the printer 
cannot feed paper unless the Rear Access Door is attached.

1.  Push the Rear Access Door into place. 

2.  Turn the latch to the right to attach the Rear Access Door to the printer.

 

printing instructions

Follow these instructions to print a two-sided document manually:

1.  Open the Printer Properties dialog box, then select the Features tab. 

2.  Check Two-Sided Printing.

The Two-Sided Printing Margin dialog box appears.

3.  Select the appropriate page content option, then click OK to return to the 
Features tab. 

4.  Select Long Side (binding on the side) or Short Side (binding at the top). 

5.  Deselect the Automatic box. 

6.  Change any other desired print settings, then click OK.

The printer automatically prints odd-numbered pages first. Once the odd-
numbered pages are printed, a message appears prompting you to reload the 
paper so that the even-numbered pages can be printed.
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Long side binding

 

Short side binding

7.  Reload the paper, then click Continue.
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using the automatic paper-type sensor

For a description of the Automatic Paper-Type Sensor feature, see Automatic Paper-Type 
Sensor.

turning off the automatic paper-type sensor

Open the file you want to print. Follow the basic printing procedures and select the 
following option:

tab setting

Quality Any paper type other than Automatic

For a description of available print options, see print settings.

turning on the automatic paper-type sensor

Open the file you want to print. Follow the basic printing procedures and select the 
following option:

tab setting

Quality Paper Type: Automatic

file:///C|/Projects/Newport/Win_UG_Hykuna/ug_using_the_automatic_paper-type_sensor_fs.html [5/9/2002 10:12:46 AM]

47



borderless_printing

borderless printing

Borderless printing lets you print to the edges of small media such as cards and photos.

4 x 6 inch photo paper with tear-off tabs: When you print on this media, the 
printout is completely borderless after the tear-off strip is removed.

 

A6 cards, greeting cards, Hagaki cards, and 4 x 6 inch photos without tear-off 
tabs: When you print on any of these media types, the printout is borderless on three 
sides with a narrow border on the bottom.

 

printing guidelines

selecting paper: Use the following paper types for borderless printing. 

●     Photo 4 x 6 in with tab

●     Photo 4 x 6 in
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●     Hagaki Card 100 x 148 mm

●     A6 Card 105 x 148.5 mm

selecting image size: Open the image file in a software application and assign the 
image size. The size corresponds to the paper size on which you want to print the 
image. When printing, select the appropriate paper size and type from the lists displayed 
on the Borderless Printing dialog box.

preparing to print

Load the paper into the printer according to the instructions for the paper type.

●     photographs 

 

loading and printing photo paper with tear-off tab: Remove the Out 
tray and, holding the tabbed edge, slide the HP Borderless Photo 
paper printable or glossy–side down, into the In tray. Replace the Out 
tray. 

●     index cards and other small media 

●     Hagaki cards 

 

using the two-sided printing option (Hagaki cards): Remove the Out 
tray and slide the paper, printable or address–side up, into the In tray. 
Print the address side first, followed by the greeting side. 

printing

1.  Select the appropriate paper type and paper size.

2.  Click a two-sided printing option when appropriate, such as for Hagaki cards.

Clicking a two-sided printing option limits the options available in the paper type 
menu. For example, photos are only printed on one side.

3.  Click OK to return to the Layout tab.

4.  Select any other desired print settings.

5.  Click OK. 
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plain paper

preparing to print

1.  Remove the Out tray.

 

2.  Slide out both paper guides.

3.  Do one of the following:

❍     For letter, executive, and B5 sized paper, place up to 100 sheets of 
paper in the In tray.

 

–or–

❍     For legal-sized and A4 paper, pull out the paper length guide, then 
place up to 100 sheets of paper in the In tray.

 

4.  Slide the paper guides firmly against the paper.
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5.  Replace the Out tray.

 

printing on plain paper

1.  Open the Printer Properties dialog box, then select the following setting:

tab setting

Quality Paper Type: Automatic or Plain Paper 

2.  Select any other desired print settings.

3.  After you have selected the print settings, click OK.

For a description of available print options, see print settings.
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envelopes

Print a single envelope using the envelope slot, or print multiple envelopes using the 
paper tray.

printing guidelines

●     Never place more than 15 envelopes in the In tray at one time.

●     Avoid using envelopes that have clasps or windows.

●     Avoid using envelopes that are shiny or embossed; envelopes with thick, 
irregular, or curled edges; or envelopes that are wrinkled, torn, or otherwise 
damaged.

●     Align the envelope edges before inserting them in the paper tray.

preparing to print a single envelope

1.  Place the envelope with the flap side on the left and facing up into the single 
envelope slot.

2.  Push the envelope forward until it stops.

 

preparing to print a stack of envelopes

1.  Remove the Out tray.
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2.  Slide out both paper guides and remove all paper from the In tray.

3.  Place no more than 15 envelopes — with the flap side on the left and facing up — 
in the In tray.

 

4.  Push the envelopes forward until they stop.

5.  Slide the paper guides firmly against the edges of the envelopes.

6.  Replace the Out tray.

 

printing the envelopes

 

If your software program includes an envelope-printing feature, follow 
the instructions provided with the software program. Otherwise, follow 
the instructions below. 

1.  Open the Printer Properties dialog box, then select the following settings:

tab setting
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Quality Paper Type: Automatic or Plain Paper 

Layout 
Orientation: Appropriate envelope orientation

Paper Size: Appropriate envelope size

2.  Select any other desired print settings.

3.  After you have selected the print settings, click OK.

 
For a description of available print options, see print settings.
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transparencies

printing guidelines

For great results use hp premium inkjet transparency film.

preparing to print

1.  Remove the Out tray.

 

2.  Slide out both paper guides, then remove all paper from the In tray.

3.  Fan the edges of the transparency sheets to separate them, then align the edges.

4.  Place up to 25 transparency sheets in the In tray with the rough side down and 
the adhesive strip toward the printer.

 

5.  Carefully push the transparencies forward until they stop so that none of the 
adhesive strips catch on one another.

6.  Slide the paper guides firmly against the transparency sheets.

7.  Replace the Out tray.
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printing transparencies

1.  Open the Printer Properties dialog box, then select the following setting:

tab setting

Quality Paper Type: Automatic or the appropriate 
transparency film 

2.  Select any other desired print settings.

3.  After you have selected the print settings, click OK.

The printer may wait for transparencies to dry before releasing them to the top of 
the tray.

For a description of available print options, see print settings.
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labels

printing guidelines

●     Use only paper labels that are designed specifically for inkjet printers.

●     Use only full sheets of labels.

●     Verify that the labels are not sticky, wrinkled, or pulling away from the 
protective backing.

●     Do not use plastic or clear labels. The ink will not dry on these labels.

●     Never place more than 20 sheets of labels in the In tray at one time.

preparing to print

1.  Remove the Out tray.

 

2.  Slide out both paper guides, then remove all paper from the In tray.

3.  Fan the edges of the label sheets to separate them, then align the label edges.

4.  Load up to 20 label sheets — label side down — in the In tray.

5.  Slide the paper guides firmly against the sheets.

 

6.  Replace the Out tray.
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printing labels
If your software program includes a label printing feature, follow the 
instructions provided with the software program. Otherwise, follow the 
instructions below. 

1.  Open the Printer Properties dialog box, then select the following settings:

tab setting

Quality Paper Type: Automatic, or the appropriate 
paper type

Layout 

Paper Size: Choose A4 or Letter (8.5 x 11 
in) 

Orientation: Appropriate orientation

Features Two-Sided Printing: Unchecked

2.  Select any other desired print settings.

3.  After you have selected the print settings, click OK.

For a description of available print options, see print settings.
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index cards and other small media

printing guidelines

●     Use only cards and small media that meet the printer’s paper size 
specifications.

●     If an out of paper message appears, verify that the index cards or other small 
media are positioned properly in the In tray.

●     To print borderless A6 (105 x 148.5 mm) cards, see borderless printing.

preparing to print index cards or other small media

1.  Remove the Out tray.

 

2.  Slide out both paper guides, then remove all paper from the In tray.

3.  Align the card edges.

4.  Place up to 30 cards in the In tray.

5.  Push the cards forward until they stop.

6.  Slide the paper guides firmly against the edges of the cards.

 

7.  Replace the Out tray.
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printing index cards and other small media
If your software program includes a card printing feature, follow the 
instructions provided by the software program. Otherwise, follow the 
instructions below.

1.  Open the Printer Properties dialog box, then select the following settings:

tab setting

Quality Paper Type: Automatic or Plain Paper 

Layout 
Paper Size: Appropriate card size

Orientation: Appropriate orientation

Features Borderless Printing: Select if you wish to use 
borderless printing. Use A6 setting

2.  Select any other desired print settings.

3.  After you have selected the print settings, click OK. 

 
For a description of available print options, see print settings.
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Hagaki cards

printing guidelines

●     Use only cards that meet the printer’s paper size specifications.

●     If an out of paper message appears, verify that the cards are positioned 
properly in the In tray.

●     To print borderless cards, see borderless printing.

preparing to print Hagaki cards

1.  Remove the Out tray.

 

2.  Slide out both paper guides, then remove all paper from the In tray.

3.  Align the card edges.

4.  Place up to 30 cards in the In tray.

5.  Push the cards forward until they stop.

6.  Slide the paper guides firmly against the edges of the cards.

 

7.  Replace the Out tray.
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printing Hagaki cards

 

If your software program includes an Hagaki card printing feature, 
follow the instructions provided with the software program. Otherwise, 
follow the instructions below. 

1.  Open the Printer Properties dialog box, then select the following settings:

tab setting

Quality Paper Type: Automatic or appropriate paper 
type

Layout 
Paper Size: Appropriate card size

Orientation: Appropriate orientation

Features 

Two-Sided Printing: Check if you want to use 
this feature

Borderless Printing: Select if you wish to use 
borderless printing

2.  Select any other desired print settings. 

3.  After you have selected the print settings, click OK.

 
For a description of available print options, see print settings.
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photographs

printing guidelines

●     The photo must be in an electronic format (digital) before it can be printed. 
Take a digital picture, scan a photo, or have your local camera shop provide an 
electronic file of the photo.

●     For best print quality, install a photo print cartridge in the printer, use a High 
Resolution print setting, and set the HP Digital Photography options.

●     To print borderless photos, see borderless printing.

●     Use hp photo papers for great results.

preparing to print small photographs
For high-quality photos, install a photo print cartridge in the printer. 
For instructions on installing a print cartridge, see replacing print 
cartridges.

1.  Remove the Out tray.

 

2.  Slide out both paper guides, then remove all paper from the In tray.

3.  Fan the edges of the photo paper to separate them, then align the photo paper 
edges.

4.  Place no more than 25 sheets of photo paper–printable side down–in the In tray.

If you are using 4 x 6 inch photo paper with a tear-off strip, load the paper with 
the tab pointing away from the printer.

5.  Push the photo paper forward until it stops.

6.  Slide the paper guides firmly against the edges of the photo paper.
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7.  Replace the Out tray.

 

preparing to print large photographs
For high-quality photos, install a photo print cartridge in the printer. 
For instructions on installing a print cartridge, see replacing print 
cartridges.

1.  Remove the Out tray.

 

2.  Slide out both paper guides, then remove all paper from the tray.

3.  Fan the edges of the photo paper to separate them, then align the photo paper 
edges.

4.  Place no more than 20 sheets of photo paper–printable side down–in the tray.

5.  Slide the paper guides firmly against the edges of the photo paper.
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6.  Replace the Out tray.

 

printing photographs

1.  Open the Printer Properties dialog box, then select the following settings:

tab setting

Quality 

Paper Type: Appropriate photo paper type

Photo Paper Printing: 

❍     PhotoREt for best print speed and 
quality, or

❍     4800 x 1200 Optimized dpi for 
source images greater than 600 dpi 
(available on some photo papers; 
requires 1200 x 1200 input dpi and 
400 MB or more hard disk space; 
takes longer to print) 

hp Digital Photography: If desired for photo 
enhancement options
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Layout 

Paper Size: Appropriate paper size

Borderless Printing: If desired for 4 x 6 inch 
photos 

Features Two-Sided Printing: Unchecked

2.  Select any other desired print settings.

3.  After you have selected the print settings, click OK.

For a description of available print options, see print settings.

If a photo print cartridge is installed in the printer, replace it with a 
black print cartridge when you finish printing photographs. For 
instructions on storing the photo print cartridge when it is not in use, 
see maintaining print cartridges.
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greeting cards

printing guidelines

●     Unfold pre-folded cards, then place them in the In tray.

●     If an out of paper message appears, verify that the cards are positioned 
properly in the In tray.

●     For great results, use hp greeting card paper.

preparing to print

1.  Remove the Out tray.

 

2.  Slide out both paper guides, then remove all paper from the In tray.

3.  Fan the edges of the greeting cards to separate them.

4.  Align the edges of the cards, then place no more than 5 cards in the In tray.

 

5.  Push the cards forward until they stop.

6.  Slide the paper guides firmly against the edges of the cards.

7.  Replace the Out tray.
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printing greeting cards

 

If your software program includes a greeting card printing feature, 
follow the instructions provided with the software program. Otherwise, 
follow the instructions below. 

1.  Open the Printer Properties dialog box, then select the following settings:

tab setting

Quality Paper Type: Automatic or appropriate paper 
type

Layout 
Paper Size: Appropriate card size

Orientation: Appropriate orientation

Features Two-Sided Printing: Check if you want to use 
this feature

2.  Select any other desired print settings. 

3.  After you have selected the print settings, click OK.

 
For a description of available print options, see print settings.
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posters

preparing to print

1.  Remove the Out tray.

 

2.  Slide out both paper guides, then remove all paper from the In tray.

3.  Fan the edges of the sheets to separate them, then align the edges.

4.  Place the paper in the In tray.

5.  Slide the paper guides firmly against the paper.

 

6.  Replace the Out tray.

 

printing posters
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1.  Open the Printer Properties dialog box, then select the following settings:

tab setting

Quality Paper Type: Automatic or appropriate paper

Layout 
Paper Size: Appropriate size

Orientation: Appropriate orientation

Features Poster Printing: Select this option, then select 
2 x 2, 3 x 3, or 4 x 4 

2.  Select any other desired print settings.

For a description of available print options, see print settings.

3.  After you have selected the print settings, click OK.

4.  After the poster has printed, trim the edges on the sheets, then tape the sheets 
together.

 

file:///C|/Projects/Newport/Win_UG_Hykuna/ug_posters_fs.html (2 of 2) [5/9/2002 10:12:51 AM]

70



banners

banners

printing guidelines

●     See the printer release notes for specific printing information.

●     Use hp banner paper for great results. 

preparing to print

1.  Remove the Out tray.

 

2.  Slide out both paper guides, then remove all paper from the In tray.

3.  Select up to 20 sheets of banner paper. Remove and discard any perforated 
strips.

4.  Place the banner paper in the In tray with the unattached edge of the paper 
facing the printer.

 

1. unattached edge

5.  Slide the paper guides firmly against the paper.

6.  Replace the Out tray.
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printing banners
If your software program includes a banner printing feature, follow the 
instructions provided with the software program. Otherwise, follow the 
instructions below. 

1.  Open the Printer Properties dialog box, then select the following settings:

tab setting

Quality 
Paper Type: Special Papers: hp banner paper 
or other banner paper

Print Quality: Normal 

Layout Paper Size: Banner [Letter (8.5 x 11 in.)] or 
Banner [A4 (210 x 297 mm)]

2.  Select any other desired print settings.

3.  After you have selected the print settings, click OK.

 
For a description of available print options, see print settings.
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iron-on transfers

printing guidelines

●     When printing a document with a mirror-image, the text and pictures are 
horizontally reversed from what appears on the computer screen.

 

●     Use hp iron-on t-shirt transfer paper for great results.

preparing to print

1.  Remove the Out tray.

 

2.  Slide out both paper guides, then remove all paper from the In tray.

3.  Fan the edges of the iron-on transfer paper to separate them, then align the 
edges.

 

4.  Place the iron-on transfer paper in the In tray with the printable side down.
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5.  Slide the paper guides firmly against the transfer paper.

6.  Replace the Out tray.

 

printing iron-on transfers

 

If your software program includes an iron-on transfer-printing feature, 
follow the instructions provided with the software program. Otherwise, 
follow the instructions below. 

1.  Open the Printer Properties dialog box, then select the following settings:

tab setting

Quality 

Paper type: Automatic or hp iron-on t-shirt 
transfers 

Print Quality: Normal or Best 

Layout 

Paper Size: A4 (210 x 297 mm) or Letter (8.5 
x 11 in.) 

Orientation: Click Mirror Image 

2.  Select any other desired print settings. 

3.  After you have selected the print settings, click OK.

For a description of available print options, see print settings.
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maintenance

●     replacing print cartridges 

●     calibrating print cartridges 

●     automatically cleaning print cartridges 

●     cleaning the print cartridge cradle 

●     maintaining print cartridges 

●     maintaining the printer body 

●     refilling print cartridges 

●     removing ink from skin and clothing 

●     tools
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replacing print cartridges

Before buying replacement print cartridges, verify the correct part numbers. For the 
correct part numbers, see print cartridges.

 

The printer can operate with only one print cartridge installed. For 
more information, see reserve mode. 

To replace a print cartridge:

1.  Press the Power button to turn on the printer. 

2.  Open the top cover.

The cradle moves to the center of the printer.

3.  Open the cradle latch. 

4.  Slide the print cartridge out of the print cartridge cradle and discard it.

1. press Power button 2. open top cover
3. open cradle latch 4. slide print cartridge out of cradle 

5.  Remove the replacement print cartridge from its packaging and carefully remove 
the plastic tape. Hold the print cartridge so that the copper strip is on the bottom.
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1. pink pull tab

Caution! Do not touch the print cartridge ink nozzles or copper 
contacts. Touching these parts will result in clogs, ink failure, and bad 
electrical connections. Do not remove the copper strips. They are 
required electrical contacts.

6.  Slide the print cartridge firmly into the cradle as shown. 

Ensure that the copper contacts of the print cartridge meet the copper contacts of 
the print cartridge cradle.

 

1. copper contacts 

7.  Close the cradle latch. Pull the latch forward, then press it down to tuck the tabs 
into place.

8.  Close the top cover.

If the Print Cartridge Status light continues to blink after installing a new print 
cartridge, verify the part number on the cartridge.

file:///C|/Projects/Newport/Win_UG_Hykuna/ug_replacecartridge_fs.html (2 of 3) [5/9/2002 10:12:53 AM]

77



replace_ink_cartridge

After you change the print cartridge, the printer is automatically calibrated for optimum 
print quality.

For information on how to recycle your empty print cartridge, see print cartridge 
recovery.

 
Warning! Keep both new and used print cartridges out of the reach of 
children.
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refilling print cartridges 

 

To get the best performance from your HP printer, use only genuine, 
factory-filled HP print cartridges. 

Caution! Damage that is directly attributable to modified or refilled HP print 
cartridges is specifically excluded from the HP printer’s warranty coverage. 
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calibrating print cartridges

After you install a print cartridge, the printer automatically calibrates the print cartridges 
to ensure the best print quality. However, if the black and color print cartridges become 
misaligned during the course of printing, you may wish to manually calibrate the 
cartridges. 

The instructions for calibrating the print cartridges vary according to how the printer was 
installed on your computer.

To view the correct instructions, answer the following question:

Does this icon appear on your computer's desktop?

 

●     Yes (use printer assistant)

●     No (use printer properties)

 

If the Yes option does not work, double-click the printer assistant 
icon on your computer's desktop, then click Tools and Updates. 

calibrating using printer properties

To calibrate print cartridges from printer properties:

1.  Open Printer Properties

2.  Select the Services tab.

3.  Click the Open the HP Toolbox button.

4.  Click Calibrate the Device, then follow the onscreen instructions.
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automatically cleaning print cartridges

If your printed pages are missing lines or dots or if streaks appear, the print cartridges 
need to be cleaned.

The instructions for cleaning the print cartridges vary according to how the printer was 
installed on your computer. To view the correct instructions, answer the following 
question:

Does this icon appear on your computer's desktop?

 

●     Yes (use printer assistant)

●     No (use printer properties)

 

If the Yes option does not work, double-click the printer assistant 
icon on your computer's desktop, then click Tools and Updates. 

cleaning using printer properties

To clean the print cartridges from printer properties:

1.  Open Printer Properties.

2.  Select the Services tab.

3.  Click the Open the HP Toolbox button.

4.  Click Clean the Print Cartridges, then follow the onscreen instructions.

If your printouts are still missing lines or dots after cleaning, a print cartridge may be 
low on ink. If so, one or both print cartridges may need to be replaced.

 

If a print cartridge is low on ink and you do not have a replacement 
cartridge available, use the printer in reserve mode.

file:///C|/Projects/Newport/Win_UG_Hykuna/ug_automatically_cleaning_print_cartridges_fs.html [5/9/2002 10:12:54 AM]

81

file:///C|/Projects/Newport/Win_UG_Hykuna/maintenance_clean.html


cleaning_the_print_cartridge_cradle

cleaning the print cartridge cradle

If the printer is used in a dusty environment, a small amount of debris may accumulate 
inside the case. This debris can include dust, hair, carpet, or clothing fibers. When it 
gets on the print cartridge cradle, it can cause smudges on printed pages. Smudges are 
easily corrected by cleaning the print cartridge cradle.

gathering cleaning supplies

You will need the following items to clean the print cartridge cradle:

●     Distilled water. Tap water contains contaminants that damage the cradle.

●     Cotton swabs or other soft, lint-free material that will not stick to the cradle.

Be careful not to get ink on your hands or clothing as you clean.

preparing to clean

1.  Press the Power button to turn on the printer, then raise the top cover.

The print cartridges move to the center of the printer.

2.  Disconnect the power cord from the back of the printer.

3.  Remove the print cartridges and place them on a piece of paper with the copper 
contacts facing up.

Do not leave the cartridges outside the printer for more than 30 minutes.

Caution! Do not touch the print cartridge ink nozzles or copper 
contacts. Touching these parts will result in clogs, ink failure, and bad 
electrical connections. Do not remove the copper strips. They are 
required electrical contacts.

cleaning the print cartridge cradle

1.  Lightly moisten a cotton swab with distilled water.

2.  Wipe the underside of the print cartridge cradle walls using the swab.
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1. print cartridge cradle 2. print cartridge cradle walls

3.  Repeat this process until no ink residue appears on a clean swab.

4.  Reinsert the print cartridges and close the printer's top cover.

5.  Reconnect the power cord to the back of the printer.
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maintaining print cartridges

The following tips will help maintain HP print cartridges and ensure consistent print 
quality:

●     Keep all print cartridges in their sealed packages until they are needed. Print 
cartridges should be stored at room temperature (60–78 degrees F or 
15.6–26.6 degrees C).

●     Do not remove the protective tape covering the ink nozzles until you are ready 
to install the print cartridge in the printer. If the plastic tape has been removed 
from the print cartridge, do not attempt to reattach it. Reattaching the tape 
damages the print cartridge.

storing print cartridges

When print cartridges are removed from either their sealed containers or the printer, 
store them in a print cartridge protector or an airtight plastic container.

A print cartridge protector comes with the photo print cartridge. If you store the print 
cartridge in an airtight plastic container make sure that the ink nozzles face down.

inserting the print cartridge into the print cartridge protector 

Slide the print cartridge at an angle into the protector, and snap it securely in place.

 

removing the print cartridge from the print cartridge protector 

Press down and back on the top of the protector to release the cartridge. Slide the 
cartridge out of the protector.
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Caution! Do not drop the print cartridge. Dropping the print cartridge may 
result in damage to the print cartridge. 
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maintaining the printer body

Because the printer ejects ink onto the paper in a fine mist, ink smudges will eventually 
appear on the printer case and adjacent surfaces. To remove smudges, stains, and/or 
dried ink from the exterior of the printer, use a soft cloth moistened with water.

When cleaning your printer, keep these tips in mind:

●     Do not clean the interior of the printer. Keep all fluids away from the interior.

●     Do not use household cleaners or detergent. In the event that a household 
cleaner or detergent is used on the printer, wipe the printer's exterior surfaces 
with a soft cloth moistened with water.

●     Do not lubricate the support rod that the print cartridge cradles use to slide 
back and forth. Noise is normal when the cradles move back and forth.
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removing ink from skin and clothing 

Follow these steps to remove ink from skin and clothing: 

to remove ink from... do this... 

skin Wash the affected area with an abrasive soap. 

white fabric Wash the fabric in cold water using chlorine bleach. 

color fabric Wash the fabric in cold water using sudsy ammonia. 

Caution! Always use cold water to remove ink from fabric. Warm or hot 
water may set the ink color into the fabric. 
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tools

The printer software contains a number of useful tools to enhance the printer's 
performance.

To access the tools, answer the following question:

Does this icon appear on your computer's desktop?

 

●     Yes (use printer assistant) 

●     No (use printer properties)

 

If the Yes option does not work, double-click the printer assistant 
icon on your computer's desktop, then click Tools and Updates. 

using the printer properties

accessing the printer properties

1.  Open the Printer Properties dialog box.

2.  Click the Services tab. 

If you do not see the Services tab, then use tools and updates.

3.  Click the Open the HP Toolbox button.

using the hp toolbox

The hp toolbox has two tabs:

●     Device services

●     Configuration

device services

The following tools are available on the Device Services tab:

●     Calibrate the Device: Calibrate the print cartridges. 
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tools

●     Clean the Print Cartridges: Clean the print cartridges. 

●     Print a Test Page: Print a test page to see if the printer can receive data. 

●     Print a Diagnostic Page: Print a diagnostic page when the HP Customer Care 
Center requests it. 

configuration

The following tools are available on the Configuration tab:

●     Accessories: Activate the Automatic Two-Sided Printing Module if it is 
installed on the printer.

●     Messages: Configure software messages.

●     Performance: Manage the Auto-off feature.
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troubleshooting 

Click the topic below that best describes the problem: 

●     printer is not printing 

●     problems with printouts 

●     printer lights are flashing or on 

●     printer is too slow 

●     automatic two-sided printing module problems 

●     borderless printing problems 

If you continue to have problems after investigating the above topics, contact HP 
Customer Care. 
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not_printing

printer is not printing

verify the following 

●     The printer is connected to the power source.

●     The cable connections are secure.

●     The printer is turned on.

●     The media is correctly placed in the paper tray.

●     The printer’s top cover is closed.

●     The duplexer or Rear Access Door is attached.

●     The print cartridges are correctly installed.

check the printer lights 

●     If the Power light is blinking, the printer is in the process of printing.

●     If the Resume light is blinking, press the Resume button.

●     If the Print Cartridge Status light is blinking, see print cartridge status light 
is flashing.

●     If the Print Cartridge Status light is on, see print cartridge status light is on.

select a topic below 

If the printer still does not print, select the topic below that best describes the problem:

●     printer makes a loud noise after a print cartridge is installed 

●     paper problems 

●     USB problems 

●     printer does not turn on 

printer makes a loud noise after a print cartridge is installed

If the print cartridge is installed backward, the printer will make a loud noise. 

1.  Open the top cover.

2.  Remove the print cartridge, then reinsert it as shown. Ensure that the copper 
contacts of the print cartridge meet the copper contacts of the print cartridge 
cradle.
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1. Copper contacts

Caution! Do not touch the print cartridge ink nozzles or copper 
contacts. Touching these parts will result in clogs, ink failure, and bad 
electrical connections. Do not remove the copper strips. They are 
required electrical contacts.

3.  Close the top cover.

4.  Press the Resume button.

Wait until the Power light stops flashing before printing a file.

paper problems

Click the topic below that best describes the problem:

●     paper jam 

●     out of paper 

●     printer ejects the paper 

paper jam
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Follow each of these steps until the paper jam is cleared.

1.  Remove the paper from the In and Out trays.

2.  Press the Resume button.

3.  If you are printing labels, verify that a label did not become detached from the 
label sheet while passing through the printer.

If the paper jam is not cleared after performing these steps and the duplexer is attached 
to the printer, see automatic two-sided printing module problems.

If the paper jam is not cleared and the duplexer is not attached to the printer:

1.  Open the Rear Access Door by turning the latch counter-clockwise and removing 
the door.

 

2.  Remove the paper jam, then replace the Rear Access Door.
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3.  Reload paper into the In tray.

4.  Press the Resume button.

5.  Print the document.

out of paper

if the paper tray is loaded 

1.  Adjust the length guide so that the paper stack touches the back of the paper 
tray.

2.  Slide the paper forward until it stops.

3.  Press the Resume button.

if the paper tray is empty 

1.  Load paper in the tray.

2.  Press the Resume button.

printer ejects the paper

●     Move the printer away from direct sunlight. The printer may have been placed 
in direct sunlight which can affect the Automatic Paper-Type Sensor. 

–or–

●     Select a paper type other than Automatic.
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USB problems

the error message “there was an error writing to LPT1” appears

The USB cable may not have been attached before installing the software. Uninstall, 
then reinstall, the software.

To uninstall the software:

●     Click here.

-or-

●     Click Start > Programs > Hewlett-Packard > [hp deskjet] > uninstall 
software, then follow the onscreen instructions.

the error message “there was an error writing to <name of USB port>" appears

The printer may not be receiving correct data from another USB device or the hub. 
Connect the printer directly to the USB port on the computer.

there are conflicting USB cable connections

A printing conflict may arise when the printer and several USB devices are attached to a 
hub. There are two methods for solving the conflict:

●     Attach the printer's USB cable directly to the computer.

– or –

●     If the printer is attached to a hub, do not use other USB devices attached to 
the hub while printing.

printer does not turn on

The printer may have drawn too much power.

1.  Disconnect the power cord from the printer.

2.  Wait approximately 10 seconds.

3.  Reconnect the power cord to the printer.

4.  Press the Power button to turn on the printer.
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problems with printouts

Click the topic below that best describes the problem:

●     print quality is poor

●     text and images are misaligned

●     document is printed off-center or at an angle 

●     parts of the document are missing or printed in the wrong place 

●     printout does not reflect new print settings 

●     photos are not printing correctly 

●     banner does not print correctly 

●     blank pages print 

print quality is poor

●     print cartridges need to be cleaned

●     print is faded

●     too much or too little ink appears on the page

print cartridges need to be cleaned

If your printed pages are missing lines or dots or if streaks appear, the print cartridges 
need to be cleaned.

For cleaning instructions, see automatically cleaning print cartridges.

print is faded

1.  Verify that a black print cartridge is installed. If the black text and images on your 
printouts are faded, you may be printing using only the tri-color print cartridge. 
Insert a black print cartridge, in addition to the tri-color print cartridge, for true 
black print resolution.

2.  Verify that neither of the print cartridges is low on ink. If a print cartridge is low 
on ink, consider replacing the print cartridge. 

 

If you do not have a replacement cartridge, remove the low-ink 
cartridge and use the printer in the reserve mode.
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3.  Verify that the plastic tape has been removed from both print cartridges. 

too much or too little ink appears on the page

In the Printer Properties box, select a paper type other than Automatic.

text and images are misaligned

If the text and images on your printouts are misaligned, then calibrate the printer.

document is printed off-center or at an angle

1.  Verify that the paper is correctly placed in the paper tray.

2.  Verify that the paper guides fit snugly against the paper.

3.  Reprint the document. 

parts of the document are missing or printed in the wrong place

Follow the basic printing instructions and verify the following options:

tab setting

Layout 

Paper Size: Verify the appropriate paper size and 
margins

Scale to Fit: Select to scale text and graphics to fit 
on the paper

Orientation: Verify the appropriate orientation

Features Poster Printing: Deselect this option if not printing 
a poster

printout does not reflect new print settings

The printer's default settings may differ from the software application's print settings. 
Select the appropriate print settings within the software application.
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photos are not printing correctly

1.  Verify that the photo media is placed in the paper tray with the print side 
down.

2.  Slide the paper forward until it stops.

3.  Slide the paper guides snugly against the paper, then push in the In tray. 

check the printer properties 

Follow the basic printing instructions and verify the following options:

tab setting

Quality 
Print Quality: Best 

Paper Type: An hp photo paper 

Layout Paper Size: Appropriate size 

banner does not print correctly

check the paper tray

●     Unfold and refold the paper when several sheets feed into the printer at once.

●     Confirm that the unattached edge of the banner paper stack is on top and 
facing the printer.

●     Verify that the correct paper for banner printing is used. 

check the printer properties 

Follow the basic printing instructions and verify the following setting:

tab setting
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Quality Paper Type: Special Papers, then select hp banner 
paper 

Layout Paper Size: Appropriate banner paper

check the software

●     Verify that the software application you are using prints banners. Not all 
software applications print banners.

●     If gaps appear at the ends of the sheets, verify that the printer software is 
operating correctly.

●     Click Start > Programs > Hewlett-Packard > [hp deskjet series] > 
release notes to view Release Notes for known software issues. 

blank pages print

●     The protective piece of plastic tape may still be attached to the print 
cartridges. Verify that the plastic tape has been removed from the print 
cartridges.

●     The print cartridges may be out of ink. Replace one or both empty print 
cartridges. 

●     The printer may be in direct sunlight. Direct sunlight can adversely affect the 
Automatic Paper-Type Sensor. Move the printer out of direct sunlight. 
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printer lights are flashing or on

●     what the flashing lights indicate 

●     Print Cartridge Status light is on 

●     Print Cartridge Status light is flashing 

●     Resume light is flashing 

●     Power light is flashing 

●     all lights are flashing 

what the lights indicate

Flashing or on lights indicate the printer status.

 

1. Print Cartridge Status light 2. Resume light 3. Power light

Resume light is flashing

the printer may be out of paper

1.  Place paper in the In tray.

2.  Press the Resume button on the front of the printer.

there may be a paper jam

Follow these instructions to clear a paper jam.
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printer lights are flashing or on

the printer may be ready to print the second side of a two-sided document

1.  Follow the onscreen instructions for printing the second side.

These instructions appear when you manually print a two-sided document.

2.  Press the Resume button.

Power light is flashing

the printer is preparing to print

The light stops flashing when the printer has received all data.

all lights are flashing

the printer may need to be restarted

1.  Press the Power button to turn off the printer, then press the Power button to 
restart the printer.

Proceed to step 2 if the lights continue to flash.

2.  Press the Power button to turn off the printer.

3.  Disconnect the printer from the power source.

4.  Reconnect the printer to the power source.

5.  Press the Power button to turn on the printer.
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printer is slow

Several variables can slow the printer's performance. Click the topic below that best 
describes the printer's performance:

●     multiple software applications are open 

●     complex documents, graphics, or photographs are printing 

●     automatic paper type option is enabled 

●     two-sided documents are printing 

If none of the above topics describes the printer's performance, then review the 
following:

●     printer driver is outdated 

●     computer does not meet system requirements 

●     printer is in reserve mode 

multiple software applications are open

If too many software applications are open, the printer cannot print at its optimum 
speed.

Close all unnecessary software applications, then print the document again.

complex documents, graphics, or photographs are printing

Documents containing graphics or photographs print slower than text documents. 

1.  Open the Printer Properties dialog box.

2.  On the Quality tab, select PhotoREt.

3.  Reprint the document. 

4.  If the document still prints too slowly, then Open the Printer Properties 
dialog box.

5.  Click the Features tab, then click Advanced Features.

6.  Select the Low Memory Mode option.

7.  Reprint the document.
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Print quality may be reduced if you use Low Memory Mode.

automatic paper type option is enabled

When the automatic paper type option is enabled, it takes a few seconds for the printer 
to scan the first page of the print job to determine the appropriate paper type.

To increase the print speed, turn off the Automatic Paper-Type Sensor.

For instructions on turning off the Automatic Paper-Type Sensor, see using the 
automatic paper-type sensor.

two-sided documents are printing

Printing two-sided documents takes more time than printing single-sided documents.

printer driver is outdated

An outdated printer driver may be installed.

For information about updating the printer driver, click here.

computer does not meet system requirements

1.  Verify that the computer's hard disk space, RAM, and processor speed meet 
system requirements.

For more information, see system requirements.

2.  Increase free space on the hard drive.

If your computer does not have enough RAM, or a large amount of free space on 
the hard drive, the printer processing time will be longer.

printer is in reserve mode

The printer may print more slowly if it is in reserve mode.

Order a replacement print cartridge.
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automatic two-sided printing problems 

automatic two-sided printing problems 

Select the topic that best describes the problem:

●     paper size changes when the two-sided printing option is selected 

●     binding margin is in the wrong place 

●     only one side of the page prints when the two-sided printing option is selected 

●     paper jam occurs inside the automatic two-sided printing module 

paper size changes when the two-sided printing option is selected

The paper size selected in the Layout tab is not supported by the Automatic Two-Sided 
Printing Module (duplexer). 

On the Layout tab in the Printer Properties dialog box, verify that a paper size 
supported by the duplexer is selected. 

binding margin is in the wrong place

You may have chosen an incorrect paper orientation. 

On the Features tab of the Printer Properties dialog box, verify that: 

●     Long side is selected for binding along the side 

●     Short side is selected for binding along the top 

only one side of the page prints when the two-sided printing option is selected

Use the following solutions: 

●     Print the document using the manual two-sided printing feature. 

●     Use a media type supported by the duplexer. 

paper jam occurs inside the automatic two-sided printing module

1.  Remove the paper from the paper trays. 

2.  Press the Resume button on the front of the printer. 
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Proceed to step 3 if the paper jam is not cleared.

3.  Turn off the printer.

4.  Press the button on top of the duplexer, then lower the access door. 

 

5.  Remove any paper from the duplexer, then close the access door. 

 

6.  Press the buttons on the left and right sides of the duplexer, then remove the unit 
from the printer. 

7.  Remove any paper jam in the printer. 

8.  Push the duplexer into the printer until it snaps into place. 

 

9.  Turn on the printer, then reprint the document. 
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borderless printing problems

image is printed at angle

if your printout looks like this... 

 

do this... 

1.  Load the paper correctly in the In tray.

2.  Verify that the paper guides fit firmly against the cards or photo paper.

3.  Follow loading instructions for the paper type. See borderless printing.

border is on top of image

if your printout looks like this... 
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do this... 

Calibrate the printer.

border is on side of image

if your printout looks like this... 

 

do this... 

Calibrate the printer.

image is above tear-off tab

if your printout looks like this... 

 

do this... 
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Calibrate the printer.

ink smears

if your printout has ink smears... 

If ink smears appear on the back of the printouts or if the paper sticks together...

do this... 

1.  Open the Printer Properties dialog box.

2.  Select the Features tab.

3.  Click Advanced Features.

4.  Slide the Dry Time pointer to the right.

5.  Click OK > OK.

If the problem persists:

1.  Remove the borderless printing media, then load plain letter or A4 paper in the In 
tray.

2.  Press and hold down the Resume button until the printer starts printing a self-
test page, then release the Resume button.

3.  Repeat step 2 until the self-test page has no ink smears on the back of the paper.
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specifications 

●     printer specifications 

●     minimum printing margins 

●     automatic two-sided printing module specifications 

●     minimum system requirements 

●     environmental statement 

●     print cartridge recovery 

●     limited warranty 

●     regulatory notices 
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printer specifications 

hp deskjet 5550 series 

black text print speed *

FastDraft: Up to 17 pages per minute

Everyday: Up to 8 pages per minute

Normal: Up to 6 pages per minute

Inkjet Paper/Best/1200 dpi text rendering: Up to 2 pages per minute

mixed text with color graphics print speed*

FastDraft: Up to 12 pages per minute

Everyday: Up to 6 pages per minute

Normal: Up to 4 pages per minute

Inkjet Paper/Best/1200 dpi text rendering: Up to 0.5 page per minute

*These are approximate figures. Exact speed varies with system configuration, software 
program, and document complexity.

black TrueType™ text resolution (depending on paper type)

Plain Paper/FastDraft: 300 x 300 dpi

Plain Paper/Everyday: 300 x 300 dpi

Plain Paper/Normal: 600 x 600 dpi

Inkjet Paper/Best/1200 dpi text rendering: 1200 x 1200 dpi

color input resolution (depending on paper type)

Plain Paper/FastDraft: 300 x 300 dpi

Plain Paper/Everyday: 300 x 300 dpi

Plain Paper/Normal: 600 x 600 dpi

Inkjet Paper/Best/1200 dpi text rendering: 1200 x 1200 dpi
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color printing resolution (subject to color input resolution above)

Plain Paper/FastDraft: 600 x 300 dpi

Plain Paper/Everyday: 600 x 600 dpi

Plain Paper/Normal: 600 x 600 dpi

Inkjet Paper/Best/1200 dpi text rendering: 1200 x 1200 dpi

4800 x 1200 optimized dpi resolution

4800 x 1200 optimized dpi color printing on premium photo papers; 1200 x 1200 input 
dpi; will require a large amount of disk space and take longer to print.

color and photo print cartridges

Up to 6 ink printing

(Requires hp photo print cartridge #58) 

For more information, see print cartridges.

print technology

Drop-on-demand thermal inkjet printing

software compatibility

MS Windows compatible (95, 98, Me, 2000, NT 4.0, and XP)

duty cycle

3000 pages per month

memory

8 MB built-in RAM

processor

96 MHz processor
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buttons and lights

Cancel button

Print Cartridge Status light

Resume button and light

Power button and light

i/o interface

Centronics Parallel, IEEE 1284–Compliant with 1284-B receptacle

Universal Serial Bus (USB) 2.0 compatible

dimensions

Without Automatic Two-Sided Printing Module:

449 mm wide x 144 mm high x 368 mm deep

operating environment

Maximum operating conditions:

Temperature: 41 to 104 degrees F, 5 to 40 degrees C

Humidity: 15 to 80 percent RH non-condensing

Recommended operating conditions for best print quality:

Temperature: 59 to 95 degrees F or 15 to 35 degrees C

Humidity: 20 to 80 percent RH non-condensing

Storage conditions:

Temperature: -40 to 158 degrees F, -40 to 70 degrees C

power consumption

2 watts maximum when off

4 watts average non-printing

30 watts average when printing
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power requirements

For power adapter part number 0950-4082 the power requirements are:

Input Voltage: 100 to 240 Vac (± 10%)

Input Frequency: 50 - 60 Hz

declared noise emissions in accordance with ISO 9296

Best Mode:

Sound power level, LWAd without Automatic Two-Sided Printing Module: 5.3 Bels (A) 
[53 dB (A)]

Sound pressure level, LpAm (bystander positions) without Automatic Two-Sided Printing 
Module: 40 dB (A)

Normal Mode:

Sound power level, LWAd without Automatic Two-Sided Printing Module: 5.9 Bels(A) [59 
dB (A)]

Sound pressure level, LpAm (bystander positions) without Automatic Two-Sided Printing 
Module: 47 dB (A)

alignment

Skew:

± .006 mm/mm (.006 in/in) on plain paper and cards

± .010 mm/mm (.010 in/in) on HP transparency films

media weight

Paper:

U.S. Letter 60 to 90 g/m ² (16 to 24 lb)

Legal 75 to 90 g/m ² (20 to 24 lb)

Envelopes: 75 to 90 g/m ² (20 to 24 lb)

Cards: Up to 200 g/m ² (110 lb index max)

Banner paper: 60 to 90 g/m ² (16 to 24 lb)

media handling
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In tray capacity: 

Plain paper sheets: Up to 100

Banners: Up to 20 sheets

Envelopes: Up to 15

Greeting cards: Up to 5 cards

Labels: Up to 20 sheets of labels (use only U.S. Letter or A4-sized sheets)

Photo paper: Up to 25 sheets

Index cards: Up to 40 cards

Hagaki cards: Up to 40 cards

Transparencies: Up to 25

Out tray capacity: 

FastDraft: Up to 35 sheets

Normal: Up to 50 sheets

Best: Up to 50 sheets

media size

Paper: 

U.S. Letter 216 x 279 mm (8.5 x 11 in)

Legal 216 x 356 mm (8.5 x 14 in)

Executive 184 x 267 mm (7.25 x 10.5 in)

A4 210 x 297 mm

A5 148 x 210 mm

B5 182 x 257 mm

Photo L 89 x 127 mm (Japan)

User Defined:

Width 77 to 215 mm (3.0 to 8.5 in)

Length 127 to 355 mm (5.0 to 14 in)

Banner: 

U.S. Letter 216 x 279 mm (8.5 x 11 in)

A4 210 x 297 mm

Envelopes: 
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U.S. No. 10 105 x 241 mm (4.12 x 9.5 in)

Invitation A2 111 x 146 mm (4.38 x 5.75 in)

DL 110 x 220 mm (8.66 x 4.33 in)

C6 114 x 162 mm (4.48 x 6.38in)

Index/Greeting Cards: 

76 x 127 mm (3 x 5 in)

102 x 152 mm (4 x 6 in)

127 x 203 mm (5 x 8 in)

A6 Cards: 105 x 148.5 mm

Hagaki: 100 x 148 mm

L size: 89 x 127 mm

Labels: 

U.S. Letter 216 x 279 mm (8.5 x 11 in)

A4 210 x 297 mm

Transparencies:

U.S. Letter 216 x 279 mm (8.5 x 11 in)

A4 210 x 297 mm

Photo (with tear-off tab):

102 x 152 mm (4 x 6 in)

print cartridges

Black: selection number 56, part number c6656a 

Tri-Color: selection number 57, part number c6657a 

Photo: selection number 58, part number c6658a 
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minimum printing margins

The printer cannot print outside a designated area of the page. Minimum print margins 
for common media types are shown below.

A4 paper

Left and Right Margins: 3.4 mm (0.134 in)

Top Margin: 1.8 mm (0.07 in)

Bottom Margin: 11.7 mm (0.46 in)

letter, legal, and executive paper

Left and Right Margins: 6.4 mm (0.25 in)

Top Margin: 1.8 mm (0.07 in)

Bottom Margin: 11.7 mm (0.46 in)

A5, B5, and user defined paper

Left and Right Margins: 3.2 mm (0.125 in)

Top Margin: 1.8 mm (0.07 in)

Bottom Margin: 11.7 mm (0.46 in)

cards (3 x 5 in, 4 x 6, 5 x 8, and A6)

Left and Right Margins: 3.2 mm (0.125 in)

Top Margin: 1.8 mm (0.07 in)

Bottom Margin: 11.7 mm (0.46 in)

Hagaki postcards

Left and Right Margins: 3.2 mm (0.125 in)

Top Margin: 1.8 mm (0.07 in)

Bottom Margin: 11.7 mm (0.46 in)

envelopes
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Left and Right Margins: 3.2 mm (0.125 in)

Top Margin: 1.8 mm (0.07 in)

Bottom Margin: 11.7 mm (0.46 in)

banners - A4 (210 x 297 mm [8.27 x 11.7 in])

Left and Right Margins: 3.4 mm (0.134 in)

Top Margin: 1.8 mm (0.07 in)

Bottom Margin: 11.7 mm (0.46 in)

Between Page Margin: 0.0 mm (0.0 in)

banners - letter (216 x 279 mm [8.5 x 11 in])

Left and Right Margins: 6.4 mm (0.25 in)

Top Margin: 1.8 mm (0.07 in)

Bottom Margin: 11.7 mm (0.46 in)

Between Page Margin: 0.0 mm (0.0 in)
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automatic two-sided printing module (duplexer) specifications

duty cycle 

3,000 pages per month

dimensions 

Printer with duplexer

449 mm wide x 144 mm high x 432 mm deep

declared noise emissions in accordance with ISO 9296 

Best Mode: 

Sound power level, LWAd with duplexer: 5.3 Bels(A) [53 dB (A)]

Sound pressure level, LpAm (bystander positions)with duplexer: 41 dB (A)

Normal Mode: 

Sound power level, LWAd with duplexer: 5.6 Bels(A) [56 dB (A)]

Sound pressure level, LpAm (bystander positions) with duplexer: 44 dB (A)

media weight 

Paper: 60 to 90 g/m² (16 to 24 lb)

Cards: up to 160 g/m2 (90 lb index maximum) 

alignment skew

± .009 mm/mm (.009 in/in) on plain paper with duplexer (2nd side)

minimum printing margins

Letter and Executive: 

Left and right margins: 6.4 mm (0.25 in)

Top and bottom margins: 11.7 mm (0.46 in)

A4: 
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Left and right margins: 3.4 mm (0.134 in)

Top and bottom margins: 11.7 mm (0.46 in)

A5, B5, 5 x 8 in Card, and User Defined Size: 

Left and right margins: 3.17 mm (0.125 in)

Top and bottom margins: 11.7 mm (0.46 in)

media size 

Paper: 

U.S. Letter: 216 x 279 mm (8.5 x 11 in)

Executive: 184 x 267 mm (7.25 x 10.5 in)

A4: 210 x 297 mm

A5: 148 x 210 mm

B5: 182 x 257 mm

Cards: 

127 x 203 mm (5 x 8 in)

102 x 152 mm (4 x 6 in)

A6 105 x 148.5 mm

Hagaki: 100 x 148 mm

media type 

hp plain paper or HP bright white inkjet paper 

hp photo quality inkjet paper, matte finish 

hp photo quality inkjet paper, semi gloss 

hp premium inkjet heavyweight paper 

hp felt-textured greeting card paper, ivory/half-fold 

hp professional brochure & flyer paper, two-sided gloss 

hp professional brochure & flyer paper, two-sided, matte finish 
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minimum system requirements

Your computer must meet the following minimum requirements to use the printer:

Microsoft Windows XP

Minimum Processor Speed: Pentium 233 MHz 

Required RAM: 128 MB 

Required Free Hard Disk Space: 40 MB*

Microsoft Windows NT 4.0 or 2000

Minimum Processor Speed: Pentium 133 MHz 

Required RAM: 64 MB 

Required Free Hard Disk Space: 40 MB*

Microsoft Windows 95, 98, or Me

Minimum Processor Speed: Pentium 150 MHz 

Required RAM: 32 MB 

Required Free Hard Disk Space: 40 MB*

* If you are printing photographs or are printing at 4800 x 1200 dpi, you must have a 
large amount of free hard disk space available.

file:///C|/Projects/Newport/Win_UG_Hykuna/ug_minimum_system_requirements_fs.html [5/9/2002 10:13:02 AM]

120



environmental

environmental statement

Hewlett-Packard continuously improves the design processes of its deskjet printers to 
minimize the negative impact on the office environment and on the communities where 
printers are manufactured, shipped, and used.

reduction and elimination

Paper use: The printer’s two-sided printing capability reduces paper usage and the 
resulting demands on natural resources. This printer is suited for the use of recycled 
papers in accordance with DIN 19 309.

Recycled paper: All paper documentation for this printer is printed on chlorine-free 
recycled paper.

Ozone: Ozone-depleting chemicals such as CFCs have been eliminated from Hewlett-
Packard's manufacturing processes.

recycling

Design for recycling has been incorporated into this printer. The number of materials has 
been kept to a minimum while ensuring proper functionality and reliability. Dissimilar 
materials have been designed to separate easily. Fasteners and other connections are 
easy to locate, access, and remove using common tools. High priority parts have been 
designed to access quickly for efficient disassembly and repair.

Printer packaging: The packaging materials for this printer have been selected to 
provide maximum protection for the least cost possible, while attempting to minimize 
environmental impact and facilitate recycling. The rugged design of the HP Deskjet 
printer assists in minimizing both packaging materials and damage rates.

Plastic parts: All major plastics and plastic parts are marked according to international 
standards. All plastic parts used in the printer housing and chassis are technically 
recyclable and all use a single polymer.

Product longevity: To ensure the longevity of your HP Deskjet printer, HP provides the 
following:

●     Extended warranty: See limited warranty.

●     Replacement parts and consumables are available for three (3) years after 
production has stopped.

●     Product take-back: To return this product to HP at the end of its useful life, 
go to www.hp.com/go/recycle. To return empty print cartridges to HP, see hp 
print cartridge recovery program. 
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energy consumption

This printer was designed with energy conservation in mind. This printer averages 4 
watts in stand-by mode. Not only does this save natural resources, but it also saves 
money without affecting the high performance of the printer.

This product qualifies for the ENERGY STAR® Program (U.S. and Japan). ENERGY STAR 
is a voluntary program established to encourage the development of energy-efficient 
office products.

 

ENERGY STAR is a US registered service mark of the USEPA. As an ENERGY STAR 
partner, Hewlett-Packard Company has determined that this product meets ENERGY 
STAR Guidelines for energy efficiency.

Energy consumption in off-mode: When the printer is off, a minimal amount of 
energy is still being consumed. Energy consumption can be prevented by turning the 
printer power off, then disconnecting the end of the printer power cord from the 
electrical source.
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print cartridge recovery 

Customers interested in recycling their genuine HP print cartridges can participate in 
HP's empty print cartridge return and recycle program. HP offers this program in the 
United States, Puerto Rico, France, Germany, and Singapore, more countries than any 
other print cartridge manufacturer in the world. This program is provided as a free 
service to HP customers as an environmentally sound solution for these products at end-
of life. 

To participate, simply request postage-paid return envelopes or bulk boxes via the Web 
at www.hp.com/go/recycle. Customers will be asked for their name, phone number, 
address, and how many bulk boxes or envelopes they would like. Postage-paid 
envelopes and/or bulk boxes will be shipped within two days. 

Because HP's unique recycling processes are very sensitive to material contamination, 
we cannot take back and recycle cartridges from other manufacturers. The end products 
of the recycling process are used in the manufacture of new products, and HP must 
ensure the composition of the material is consistent. To do that, we recycle only HP 
original cartridges. This program does not extend to refilled cartridges. 

Returned cartridges are separated for purification into raw materials for use in other 
industries to manufacture new products. Examples of products made from recycled HP 
print cartridge materials include automobile parts, trays used in microchip fabrication 
processes, copper wire, steel plates, and the precious materials used in electronics. 
Depending on the model, HP is able to recycle up to 65% of the print cartridge by 
weight. The remaining parts that cannot be recycled (ink, foam and composite parts) are 
disposed of in an environmentally responsible manner. 
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limited warranty

region software printer

Japan 90 days 1 year

extent of limited warranty

Hewlett-Packard (HP) warrants to the end-user customer that the HP products specified 
above will be free from defects in materials and workmanship for the duration specified 
above, which duration begins on the date of purchase by the customer. Customer is 
responsible for maintaining proof of date of purchase. 

1.  For software products, HP's limited warranty applies only to a failure to execute 
programming instructions. HP does not warrant that the operation of any product 
will be uninterrupted or error free. 

2.  HP's limited warranty covers only those defects which arise as a result of normal 
use of the product, and do not apply to any:

❍     Improper or inadequate maintenance or modification; 

❍     Software, interfacing, media, parts, or supplies not provided or 
supported by HP; or 

❍     Operation outside the product's specifications. 

❍     For HP printer products, the use of a non-HP ink cartridge or a refilled 
ink cartridge does not affect either the warranty to the customer or any 
HP support contract with the customer. However, if printer failure or 
damage is attributable to the use of a non-HP or refilled ink cartridge, 
HP will charge its standard time and materials charges to service the 
printer for the particular failure or damage. 

3.  If HP receives, during the applicable warranty period, notice of a defect in any 
software, media, or ink cartridge covered by HP's warranty, HP shall replace the 
defective product. If HP receives notice of a defect in any hardware product 
covered by HP's warranty during the applicable warranty period, HP shall either 
repair or replace the defective product at HP's option. 

4.  If HP is unable to repair or replace, as applicable, a defective product covered by 
HP's warranty, HP shall, within a reasonable time after being notified of the 
defect, refund the purchase price of the product. 

5.  HP shall have no obligation to repair, replace, or refund until the customer returns 
the defective product to HP. 
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6.  Any replacement product may be either new or like-new, provided that it has 
functionality at least equal to that of the product being replaced. 

7.  HP's limited warranty is valid in any country where the covered HP product is 
distributed by HP except for the Middle-East, Africa, Argentina, Brazil, Mexico, 
Venezuela, and France's "Departements D'Outre-Mer"; for those excepted areas, 
the warranty is valid only in the country of purchase. Contracts for additional 
warranty services, such as on-site service, may be available from any authorized 
HP service facility where the product is distributed by HP or by an authorized 
importer. 

8.  Any applicable print cartridge warranty shall not apply to HP print cartridges that 
have been refilled, remanufactured, refurbished, misused, or tampered with in 
any way. 

limitations of warranty

1.  TO THE EXTENT ALLOWED BY LOCAL LAW, NEITHER HP NOR ITS THIRD PARTY 
SUPPLIERS MAKE ANY OTHER WARRANTY OR CONDITION OF ANY KIND, 
WHETHER EXPRESS OR IMPLIED, WITH RESPECT TO THE HP PRODUCTS, AND 
SPECIFICALLY DISCLAIM THE IMPLIED WARRANTIES OR CONDITIONS OF 
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR 
PURPOSE. 

limitations of liability

1.  To the extent allowed by local law, the remedies provided in this Warranty 
Statement are the customer's sole and exclusive remedies. 

2.  TO THE EXTENT ALLOWED BY LOCAL LAW, EXCEPT FOR THE OBLIGATIONS 
SPECIFICALLY SET FORTH IN THIS WARRANTY STATEMENT, IN NO EVENT WILL 
HP OR ITS THIRD PARTY SUPPLIERS BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER BASED ON CONTRACT, 
TORT, OR ANY OTHER LEGAL THEORY AND WHETHER ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. 

local law

1.  This Warranty Statement gives the customer specific legal rights. The customer 
may also have other rights which vary from state to state in the United States, 
from province to province in Canada, and from country to country elsewhere in 
the world. 

2.  To the extent that this Warranty Statement is inconsistent with local law, this 
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Warranty Statement shall be deemed modified to be consistent with such local 
law. Under such local law, certain disclaimers and limitations of this Warranty 
Statement may not apply to the customer. For example, some states in the 
United States, as well as some governments outside the United States (including 
provinces in Canada), may: 

❍     Preclude the disclaimers and limitations in this Warranty Statement from 
limiting the statutory rights of a consumer (e.g., the United Kingdom); 

❍     Otherwise restrict the ability of a manufacturer to enforce such 
disclaimers or limitations; or 

❍     Grant the customer additional warranty rights, specify the duration of 
implied warranties which the manufacturer cannot disclaim, or not allow 
limitations on the duration of implied warranties. 

3.  FOR CONSUMER TRANSACTIONS IN AUSTRALIA AND NEW ZEALAND, THE TERMS 
IN THIS WARRANTY STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, 
DO NOT EXCLUDE, RESTRICT, OR MODIFY, AND ARE IN ADDITION TO, THE 
MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF HP PRODUCTS 
TO SUCH CUSTOMERS. 

obtaining a warranty extension 

If you would like to extend your warranty coverage beyond the limited warranty period, 
use one of the following options: 

●     Consult your reseller to get extended coverage. To find HP resellers in the 
U.S., visit HP's service locator at www.hp.com/service_locator. 

●     If your reseller does not offer service contracts, call HP directly and ask about 
our HP service agreements. In the U.S. call (800) 446-0522; in Canada call 
(800) 268-1221. For HP service agreements outside of the U.S. and Canada, 
contact your local HP sales office. 

file:///C|/Projects/Newport/Win_UG_Hykuna/ug_printer_warranty_fs.html (3 of 3) [5/9/2002 10:13:03 AM]

126



ink_warranty

regulatory notices 

hewlett-packard company

This device complies with part 15 of the FCC Rules. Operation is subject to the following 
two conditions:

●     This device may not cause harmful interference, and 

●     This device must accept any interference received, including interference that 
may cause undesired operation. 

Pursuant to part 15.21 of the FCC Rules, any changes or modifications to this equipment 
not expressly approved by Hewlett-Packard Company may cause harmful interference, 
and void your authority to operate this equipment. Use of a shielded data cable is 
required to comply with the Class B limits of part 15 of the FCC Rules.

For further information, contact:

Hewlett-Packard Company

Manager of Corporate Product Regulations

3000 Hanover Street

Palo Alto, CA 94304

(605) 857-1501

note

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to part 15 of the FCC rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, can cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the following 
measures:

●     Reorient or relocate the receiving antenna. 

●     Increase the separation between the equipment and the receiver. 

●     Connect the equipment into an outlet on a circuit different from that to which 
the receiver is connected. 
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●     Consult the dealer or an experienced radio/TV technician for help. 

LED indicator statement

The display LEDs meet the requirements of EN 60825-1.
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